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Apresentação:

O AutoCAD é um programa de CADD (Computer Aided Draft and Design - Desenho e Projeto Auxiliado 
por  Computador  -  ou  somente  CAD).  A AutoDesk  Inc.  apresentou  a  Versão  1.0  do  AutoCAD  na 
COMDEX em Las Vegas em novembro de 1982. Por sua arquitetura aberta, torna-se um ambiente ideal 
para o desenvolvimento de aplicativos por terceiros, permitindo a utilização em praticamente qualquer 
área de desenho e projeto, tanto como engenharia, arquitetura, agrimensura, indústria, científico, design 
ou qualquer outra aplicação que necessite de desenho e projeto auxiliado por computador.

1. Um pouco de história:

O que é CAD (Desenho e Projeto Auxiliado por Computador)? O desenho e projeto auxiliado por 
computador tiveram início com a indústria aeroespacial e automobilística, nos fins da década de 60. Até 
então, os projetos eram limitados a desenhos manuais, sujeitos a imprecisão humana. Com a evolução dos 
computadores, sistemas complexos de CAD eram desenvolvidos,  mas limitados às grandes empresas. 
Com o advento dos computadores PCs, uma revolução teve início,  basicamente pelo baixo custo dos 
equipamentos,  e  muitas  opções  de  programas.  Um  destes  programas  é  o  AutoCAD,  criado  pela 
AutoDesk Inc., nos EUA. Inicialmente o programa era destinado a desenhos mecânico. Devido a sua 
arquitetura  aberta,  logo se  tornou  um padrão  para  desenvolvedores  de  sistemas,  contando  hoje  com 
milhares de desenvolvedores por todo o mundo.

Outros sistemas de CADD também se firmaram como padrão, como o Micro-Station e o Vector 
Works.  Sistemas  de  CAD  (projeto  e  desenho),  CAM  (Manufatura),  CAE  (Engenharia),  GIS 
(Geoprocessamento)  específicos  tem  sido  criados,  destinados  à  mecânica,  agrimensura,  engenharia, 
arquitetura,  topografia,  estradas,  modelagem,  tais  como  o  AutoCAD,  AutoSurf,  AutoArchitect, 
AutoBuilding, Cad Overlay, Catia, GisPlus, EMS e Hiteck.

2. Evolução das versões do AutoCad:

Desde  o  seu  lançamento  em  1982,  o  AutoCAD  tem  passado  por  diversas  revisões  e  alterações, 
melhorando os recursos do programa, sendo:
-Versão 1.0 R.1 (11/1982)
-Versão 1.2 R.2 (04/1983)
-Versão 1.3 R.3 (08/1983)
-Versão 1.4 R.4 (10/1983)
-Versão 2.0 R.5 (10/1984)
-Versão 2.1 R.6 (05/1985)
-Versão 2.5 R.7 (07/1986)
-Versão 2.6 R.8 (04/1987)
-Release 9 (09/1987)
-Release 10 (07/1988)
-Release 11 (10/1990)
-Release 12 (06/1992)
-Release 13 (11/1994)
-Release 14 (02/1997)
-R-2000 (R-15) (02/1999)
-R-2002 (R-15) (02/2001)
-R-2004 (R-16) (03/2003)
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4. Compatibilidade de arquivos:

Todas as novas versões do AutoCAD, são compatíveis com os arquivos de versões anteriores, mas 
não vice-versa.  Isto é o AutoCAD 2004 lê os arquivos das versões anteriores,  mas as anteriores não 
podem ler os arquivos do AutoCAD 2004. O AutoCAD 2004 lê e converte os arquivos da versão 12, 13, 
14, 2000 e 2002 para a versão R2004 e pode exportar os arquivos DWG com formato da versão R-2000 
somente, e como arquivos do tipo DXF da versão R-12 e R-2000.

Os arquivos do AutoCAD 2004 não são compatíveis  com o AutoCAD 2004. Se você desejar 
trabalhar com outros profissionais que tem o AutoCAD 2004, você deve salvar o seu arquivo no formato 
da  versão  R-2000.  Você  pode  configurar  o  AutoCAD para  fazer  isto  automaticamente:  Vá ao  menu 
Tools→Options→Open and Save: em File Save escolha: AutoCAD2000/LT2000 Drawing.

5. Carregando o AutoCad:

Ligue o computador, e dentro do Windows, escolha no menu INICIAR a opção PROGRAMAS e 
depois a opção AutoDesk /AutoCAD 2004 e depois o ícone do programa (também está escrito AutoCAD 
2004), e dê um click com o botão esquerdo do mouse, iniciando o programa (também se pode utilizar o 
atalho que está sobre a Área de Trabalho).

Aparecerá o quadro Start Up solicitando que você utilize uma ajuda para inicializar um rascunho 
(Scratch), ou começar por um protótipo (Template), novo desenho (Wizard), ou ainda abrir um desenho 
existente (Open).
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6. Dentro do programa AutoCad 2004

Quando já carregado, o AutoCAD 2004 apresenta a tela semelhante a representada ao lado.
Esta tela contém vários itens que merecem serem estudados individualmente.
A tela visível é chamada de tela gráfica,  onde se visualiza várias informações. Um cursor em 

forma  de  duas  linhas  perpendiculares  (x-hair)  indica  o  ponto  de  inserção  das  entidades  que  serão 
desenhadas.

E várias outras partes do programa a seguir:
• Barra de Titulo:

Nesta barra aparece o nome do programa e o nome do desenho em edição.

• Barra de Menus Pull-down:

Nesta barra aparece o nome dos principais grupos de menus.

• Barra de Menu de ícones padrão (Standard Toolbar):
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Nesta barra encontra-se os ícones de comandos mais utilizados, sendo: New, Open, Save, Print,
Print Previw, Spelling, Cut to Clipboard, Copy to Clipboard , Paste from Clipboard, Match
Properties, Undo, Redo, Launch Brownser, Oject Snap, UCS, Inquiry, Redraw, Aerial View,
Named View, Pan Realtime, Zoom Realtime, Zoomt, Zoom Previous e Help.

• Barra de Menu de Propriedade de Objetos:

Esta barra permite visualizar e executar principais mudanças em entidades e ambiente de trabalho 
durante a edição, sendo: Color Control, Linetype, Linetype Control, Lineweight Control e Plot Style

• Barra de Menu de layer:

Esta barra de ferramentas permite alteração de layer de trabalho e também a mudança de layer
das entidades, sendo: Layer porperties, Make Object’s Layer Current, Layers Previous.

• Menus em cascata:

Nos itens de menu que tiveram uma seta à direita, tem-se a 
opção de abrir  em menus tipo  cascata,  basta  do para isso 
acompanhar o mouse sobre o texto, e quando o item desejado 
estiver destacado, click com o botão esquerdo do mouse para 
executar  o  comando.  Neste  tipo  de  comandos  não  é 
necessário completar outros tipos de alternativas para a sua 
execução.

• Menu de quadro de diálogo:
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Nos  itens  de  menu  que  tiverem 
uma  reticência  à  direita,  tem-se  a 
opção de  abrir  quadros  de diálogos, 
bastando  para  isso  acompanhar  o 
mouse sobre o texto, e quando o item 
desejado estiver destacado,  click  com 
o  botão  esquerdo  do  mouse  para 
chamar  o  quadro.  Estes  quadros 
devem ser preenchidos em sua grande 
variedade  de  opções  para  que  a 
execução do comando seja realizada.

• Menu de tela (screen menu):

Este é o maior e mais completo menu do AutoCAD. Ele 
permite  uma  compatibilidade  de  menus  com  as  versões 
antigas do programa. Para deixa-lo visível vá à opção: Tools 
→ Options → Display → Display Screen Menu. Tem-se ao 
topo deste menu a palavra AutoCAD. Quando se seleciona 
um item neste menu, pode-se abrir outro menu com itens 
//relacionado ao anterior ou respostas possíveis ao comando 
acessado por  este  menu.  Muitas  vezes  utilizando o menu 
pulldown,  o  menu  de  tela  também será  acessado  para  o 
comando especificado.
Este menu pode ser posicionado em qualquer canto da tela 
gráfica.

• Linha de comando e Tela gráfica:

Onde são visualizados e editados os comandos chama-se tela gráfica.
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Uma  área de  Prompt  na  parte  inferior  do  programa permite  a  visualização  da  digitação  dos 
comandos e as respostas aos comandos feitos pelo AutoCAD. Para alternar entre a tela gráfica e a tela de 
texto pressione a tecla F2.

• Barra de status:

Abaixo da linha de comando, encontra-se a  barra de status, onde se visualiza as coordenadas, snap 
mode, grid display, ortho mode, polar tracking, object snap, object osnap tracking, show/hide lineweight e 
model ou paperspace e communication center.

7. Teclas de funções no AutoCad:

Algumas teclas de funções têm uso específico no AutoCAD, sendo:

F1 No Windows esta tecla é de Ajuda (help).

F2 Alterna-se entre a tela gráfica e tela de texto.

F3 Permite ligar e desligar o object snap e também quando todos os snap estão desligados, o acesso ao 
quadro de diálogo Drafting Settings.

F4 Alterna o acesso do cursor entre o menu pull-down e sobre a área de digitalização quando se utiliza 
uma mesa digitalizadora.

F5 Alterna entre os planos isométricos (isoplane top, left, rigth).

F6 Liga e desliga o contador de coordenadas.

Dentro de um comando como, por exemplo, line, tem ainda três posições:
-coordenadas absolutas, onde são mostrados apenas as coordenadas X e Y do cursor.
-coordenadas relativas, onde são mostradas as coordenadas polares do cursor em relação ao último ponto 
marcado na tela, isto é, indica a partir deste ponto, uma distância e um ângulo até o cursor.
-desligado, último ponto do cursor na tela.

F7 Liga e desliga o GRID, que são pontos visíveis na tela, utilizados apenas para a referência no desenho.

F8 Liga e desliga o ORTHO, que permite somente o desenho de linhas ortogonais ao cursor X-hair. Obs: 
Por falta de conhecimento, muitos acham que o AutoCAD só pode desenhar ortogonalmente nos ângulos 
pré-definidos de 0º, 90º, 180º e 270º, o que não é verdade. Pode-se rotacionar o eixo ortogonal para 
qualquer  ângulo  desejado,  bastando  configurar  o  comando  snapang,  ou  dentro  do  quadro  Drafting 
Settings, em Snap and Grid, modifique o valor de Angle.

F9 Liga e desliga o SNAP, que funciona como um tipo de imã - não permite manter o cursor fora do snap.

F10 Liga e desliga a opção de POLAR, que permite que sejam desenhadas linhas dentro de outros eixos, 
além do ortogonal.
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F11 Liga e desliga o OBJECT SNAP TRACKING, permitindo uma busca acelerada do objeto snap.

8. Conceitos sobre a área gráfica:

Para entender melhor o ambiente de desenho do AutoCAD, deve-se entender alguns conceitos básicos 
utilizados no programa (e praticamente em todos os tipos de programas de CAD).

GRID: São pontos visíveis na tela, utilizados apenas para a referência no desenho. Os grids podem ser 
alterados de aspecto, podendo ter valores de espaçamentos diferentes, tanto no X, como no Y. Liga e 
desliga com a tecla F7 ou pela Barra de Status.

SNAP: É uma espécie de malha, que não permite que o cursor ande fora dela. Funciona como um tipo de 
imã, prendendo o cursor a esta malha. É muito útil para um desenho com precisão e velocidade. Liga e 
desliga com a tecla F9 ou pela Barra de Status.

UNIDADE DE TRABALHO: No AutoCAD a unidade de trabalho é admensional, isto é, definida pelo 
usuário, não existe unidade fixa, pode ser, centímetros, metros, polegadas, milhas, ano-luz, etc. Ajusta-se 
com a opção de menu Format→ units.

LIMITE DO DESENHO: Devido ao fato de não ter uma unidade de trabalho fixa, o limite do desenho, 
também não é fixo, portanto é praticamente infinito. Ajusta-se com a opção de menu Format→drawing 
limits.  A grid somente aparecerá dentro destes limites do desenho. Existe uma outra opção do comando 
limits,  que  quando  estiver  ligado  não  permite  desenhar  fora  dos  limites  definidos,  portanto  faça  o 

comando limits ficar em off.

ZOOM: A tela gráfica é apenas uma pequena janela que 
se movimenta sobre o desenho. Pode-se coloca-la sobre 
qualquer  parte  dele,  com  qualquer  incremento  de 
visualização.  Pode-se desenhar  com precisão  um prédio 
com  uma  cidade  ou  estado  em  torno  dele,  ou  mesmo 
desenhar uma bactéria na cozinha deste mesmo prédio.

9. Introdução ao editor gráfico:

Menu File:
New É apresentado o quadro Create New Drawing. Inicia 
um  novo  desenho  a  partir  de  um  desenho  template  já 
configurado  (normalmente  é  o  desenho  acad.dwt),  ou 
permite a escolha de outro desenho template, onde já está 
definido o tipo de letras, layers, blocos, tipos de linhas, 
estilos de dimensionamento, etc. Outra opção, é começar 
pelo  Wizard,  que  lhe  permite  configurar  alguns 
parâmetros do desenho e no final é inserido um formato 
vazio.

Open Abre um desenho já existente.

Save Salva a edição corrente. Se não foi dado um
nome ao desenho, o AutoCAD lhe pedirá um nome.
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Save As  Salva um desenho sem nome em um arquivo ou renomeia o desenho corrente  (ou também 
permite gravar o seu desenho como template .dwt).

Export  Permite exportar arquivos para outros programas CAD. O formato de arquivo mais comum em 
CAD é o DXF (Arquivo de Intercâmbio de Desenho), por exemplo, pode-se exportar os seus desenhos em 
arquivos no formato DXF para serem utilizados por um programa de cálculo de estrutura ou um programa 
artístico vetorial como o Corel Draw.

Page  Setup  Abre  o  quadro  de  configuração  page  Setup,  permitindo  configurar  a  impressora  a  ser 
utilizada. Também permite configurar o espaço do modelo (model) ou o espaço do papel (layout).

Plot Preview Mostra como o desenho será visto quando impresso ou plotado.

Print (ou plot) Envia o desenho para que seja impresso em uma impressora gráfica, plotter, ou que seja 
gravado em um arquivo de plotagem para ser levado a um  bureal de serviço.  Também permite gerar 
arquivos em formato  .dwf  para utilização em páginas de Internet. A opção de impressão será detalhada 
mais adiante.

Drawing  Utilities  →  Audit  /  Recover  Verifica  ou  Recupera  um  arquivo  de  desenho  danificado. 
Normalmente  um erro  no  desenho  do  AutoCAD pode  ocorrer  durante  a  leitura  ou  escrita  no  disco 
Winchester ou diskette.

Drawing Utilities  → Purge  Permite eliminar do desenho, elementos de blocos, tipos de linhas,  layers, 
estilo de dimensionamento, de letras que não estão sendo mais utilizados pelo desenho.

Send Envia o desenho corrente para o correio eletrônico (e-mail).

Exit Permite sair do AutoCAD. Se a edição ainda não foi salva, o programa lhe perguntará se ela deverá 
ser salva.

Menu Edit:

Localiza-se neste  menu os  recursos  de edição 
do  Windows,  como  desfazer  (undo),  refazer  (redo), 
recortar (cut), copiar (copy) e colar (paste). O comando 
Copy  que  permite  a  inserção  de  objetos  da  área  de 
transferência do
Windows, ou outros tipos de formatos de dados.

Uma  boa  maneira  de  ganhar  velocidade  no 
trabalho  com o  AutoCAD é  um utilização  constante 
dos comandos  copy  e  paste. Selecionam-se os objetos 
com os recursos de
grips  e faz-se o  copy  e posteriormente faz-se o  paste. 
Um outro modo interessante é a utilização do Paste as  
block para a criação de blocos rápidos.

O comando Copy Link e Paste Special  permite 
utilizar  a  tecnologia  OLE  (object  linking  and 
embedding) do Windows, inserindo partes de arquivos 
de outros programas. O comando Clear, é o comando 
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eraser do AutoCAD. OLE Links permite atualizar, modificar e cancelar links OLE existente. Find permite 
encontrar um texto no desenho e se necessário substituí-lo por outro.

Menu e Toolbar draw:

Line Desenha linhas simples. Desenha uma linha de um ponto a outro, e aguarda mais um outro ponto 
para continuar desenhado linhas. Finaliza-se o comando com Enter  ou  ESC. Para desenhar linhas com 
medidas exatas, utilize o Snap ligado ou entre com os dados através de um processo de entrada de dados.  
(Entrada de dados: veja mais adiante).

Ray  Desenha uma linha com início e sem fim.  Permite  criar  linhas de construção para o auxilio do 
desenho.

Construction Line  (xline)  É uma linha infinita.  Permite criar  linhas de construção para o auxilio  do 
desenho.

Polyline Desenha linhas contíguas. Também permite o desenho de arcos dentro do mesmo comando. É 
muito utilizado também para achar uma área, bastando desenhar um polígono e pedir a sua área com o 
comando Area.

Poligon Desenha polígonos, que são polilinhas fechadas, definidas pelo lado, inscrito em um círculo ou 
circunscrito por um círculo.

Retangle Desenha um retângulo. Pede apenas dois pontos em diagonal na tela.

Revcloud Desenha um nuvem de revisão

Spline Cria curvas spline quadrática ou cúbica através de matemática nurbs (nurbs: nonuniform rational  
B-spline curve).

Circle Desenha círculos pelo centro e raio; centro e diâmetro; 2 pontos; 3 pontos; duas tangente e raio e 
três tangentes.

Arc  Desenha arcos. Deve-se sempre considerar o sentido anti-horário para o desenho dos arcos. Este 
comando desenha arcos por: Arc Continue Continua a desenhar arcos a partir do último arco desenhado.

Elipse  Desenha elipses pelo centro e eixos ou pelo centro e dois eixos. Também desenha um arco de 
ellipse.

Block Veja mais adiante na seção de Blocos.

Point  Desenha um ponto utilizado normalmente para dividir  linhas,  polilinhas e arcos em dimensões 
iguais com o comando divide e measure. Para mudar o estilo do ponto apresentado na tela, deve-se altera 
o comando Point Style: menu Format→Point Style; e depois no prompt
command digite:  Regen  (ou menu  View→Regen).  Isto forçará um redesenho da tela, permitindo ver os 
pontos desenhados.
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Region Cria o objeto Region a partir de objetos existente (utilizado para 3D).

Solid Desenha uma área fechada com 3 ou 4 lados preenchida com uma cor.

-Fill on preenchimento ligado
-Fill off preenchimento desligado
Atenção no sentido de construção do sólido. Veja no desenho acima.

Dica: Utilizar o comando  Solid  para simular mesas sobre pisos hachurado, utilizando em conjunto os 
comandos elevation e o hide.

Hatch Preenche uma área com um padrão de Hachura. Estes padrões podem ser de quatro tipos: definido 
pelo usuário, que se consiste em linhas paralelas ou em uma malha quadrada; padrões armazenados, que 
são tipos complexos de hachura; padrões custom que são novos padrões acrescentados pelo usuário; e 
padrões gradiente. O processo de seleção das entidades pode variar de simples seleção, ou por pesquisa de 
fronteiras do espaço a ser hachurado. Também se pode adicionar ou remover o espaço selecionado.
Na versão R-2004 existe a nova hachura com gradiente de cores, permitindo a criação de efeitos artísticos 
para a apresentação de plantas e fachadas.

Mtext e Text Veja mais adiante na seção sobre Textos.

Menu e Toolbar Modify:

Está agrupado neste item do menu os comandos de construção, isto é, comandos que constroem uma nova 
entidade a partir de uma já existente, ex.: comando copy (diferente dos comandos do grupo MODIFY que 
apenas modificam as entidades, ex.: comando move).

Erase Apaga uma entidade ou um grupo de entidades selecionadas.

Copy Copia uma entidade ou um grupo de entidades selecionadas de um ponto base para um ponto final. 
A opção multiplus permite a cópia do mesmo objeto várias vezes.

Mirror Espelha uma entidade ou um grupo de entidades selecionadas por uma linha de espelho definida 
por dois pontos. A distância dos objetos a linha de espelho é igual. O comando pergunta se mantém ou 
apaga o objeto original.

Offset  Faz a cópia para o lado (offset) de linhas, polilinhas, arcos e círculos. O comando inicialmente 
pergunta pela distância do offset.

Array Gera um arranjo com uma entidade ou um grupo de entidades selecionadas. Tendo como opção o 
array retangular, onde as entidades se alinham em torno de colunas e linhas, ou o array polar, onde as 
entidades  se  organizam  em  torno  de  um  eixo.  O  array  polar  ainda  pode  ser  rotacionado  ou  não 
rotacionado.
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Move Altera a localização das entidades selecionadas. Para a execução do comando, selecione um grupo 
de entidades, dê um pick para o ponto início do movimento e um pick para o fim do movimento.

Rotate Rotaciona uma entidade ou um grupo de entidades em torno de um ponto base. O comando tem a 
opção reference que permite a mudança da referência (o ângulo default é zero).
A opção reference permite pegar uma nova referência para a rotação das entidades (já que o valor default  
é 0), permitindo utilizar um dos lados conhecido da entidade.
1-2- pega-se a referência no ângulo conhecido
3- leva-se ao novo ponto destino

Scale Modifica a escala de uma entidade ou um grupo de entidades selecionadas. O valor de escala maior 
que 1 aumenta, e menor que 1 diminui. O comando pede um ponto de base para a partir dele executar a 
ação.  (Apenas  alguns  objetos  quando  desenhados  sofrerão  escala,  como  Blocos  de  Simbologia  e 
Formatos. Veja na mais adiante em Blocos).

Stretch Estica as entidades selecionadas. Só podem ser utilizados os modos de seleção crossing e window 
(também WC e CP) para este comando. (Este comando também existe dentro da opção de edição por 
Grips. Veja mais adiante).

Trim Corta linhas, polilinhas e arcos em relação a uma outra entidade (fronteira). As fronteiras devem 
estar cruzando as entidades.
1° - Seleciona-se as fronteiras
2° - Seleciona-se as entidades a serem cortadas
dica: pode-se selecionar tudo como fronteira e depois ir cortando o que é desejado

Extend Extende uma linha, polilinha ou arco em direção a uma outra entidade (fronteira).
As fronteiras devem estar no alcance das entidades.
1° - Seleciona-se as fronteiras
2° - Seleciona-se as entidades a serem extendidas

Break Quebra linhas, polilinhas, círculo ou arco em um ou dois pontos.

Chanfer Semelhante ao fillet, faz a união das pontas de duas linhas, polilinhas ou arcos. Também permite 
fazer a concordância de linhas através de um chanfro, com as distâncias definidas pelo comando.

Fillet Faz a união das pontas de duas linhas, polilinhas ou arcos. Também permite fazer a concordância de 
linhas através de um arco, com raio definido pelo comando.  Explode Explode (desagrupa) as entidades 
como:  blocos,  polilinhas,  hatch,  dimensionamento,  malhas  e  sólidos.  Não  se  deve  explodir 
dimensionamento (cotas). Pode existir no desenho  blocos aninhados, isto é, blocos criados com outros 
blocos. Para explodi-los será necessário explodi-lo várias vezes, inicialmente o bloco principal, depois os 
outros demais blocos internos.

Lengthen Modifica o comprimento do objeto selecionado (Utilize a opção dynamic).

Outros comandos de edição:

U Desfaz os comandos executados, um por vez. Cuidado com este comando, pois uma vez feito o recuo 
na edição não pode mais ser desfeito.
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Undo Desfaz os comandos quantas vezes desejadas, até chegar no início da abertura da edição. Permite 
criar uma marca tipo “memória”.

Redo Refaz apenas o último comando U ou Undo.

Select Prepara um grupo de entidades que fica aguardando a ação de um comando. Pode-se utilizar para 
este comando qualquer modo de seleção dentro dele. (Pega-se o grupo de seleção feito com o comando 
select, utilizando a opção previous dentro de um comando qualquer).

Properties Faz mudanças diversas sobre as entidades selecionadas, como: cor, layer, thickness, elevation, 
posição. (veja o Menu Tools).

10. Criação e edição de textos:

Mtext Permite escrever com a opção de texto múltiplo. Pede-se dois pontos na tela abrindo uma caixa de 
texto. Após isto, apresentará o quadro de diálogo ao lado, podendo modificar várias características da 
fonte. 

Dtext Comando de texto dinâmico. Normalmente utilizado para escrever somente uma linha de texto no 
desenho, como nome de cômodos, numeração de portas e janelas, etc. Quando se escreve, tudo aparece na 
tela. A sequência do comando é a seguinte:
- Ponto inicial do texto,
- Pede-se a altura do texto (somente se o estilo de letra tiver altura = 0 - Veja text style),
- Ângulo de rotação,
- Escreve-se o texto,
- Com enter finaliza-se o comando.
Tanto o comando Mtext como o Dtext permitem modificar a justificativa do texto.

Style Opção do comando dtext que permite escolher o estilo de letra que será utilizado.

Default Escreve o texto alinhado pela esquerda.

Right Escreve o texto alinhado pela direita.

Align Escreve o texto alinhado por dois pontos, mantendo as proporções originais da letra.

Fit  Escreve o texto alinhado por dois pontos, mas preenchendo o espaço entre estes pontos, mantendo 
altura original da letra e deformando a largura (width).

Center Escreve o texto centralizado.
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Middle Escreve o texto centralizado horizontal e verticalmente.

Mirrtext  Variável  que  controla  o  espelhamento  do  texto  através  do  comando  Mirror.  Normalmente 
utiliza-se a variável mirrtext = 0.

Fontes O AutoCAD permite a utilização das fontes do Windows (fontes fft) e também uma série de fontes 
especiais para símbolos. O AutoCAD utiliza fontes especiais que são as fontes shx. Utilize estas fontes em 
seu desenho, pois são mais rápidas para o computador. As principais fontes SHX são as fontes Simplex e 
Romans.

Definindo uma fonte:

Para definir uma fonte nova, segue-se a seguinte seqüência abaixo:
• Vá ao menu Format→ Text Style;
• Cria-se um novo estilo com a opção New.
• Escolhe a fonte, podendo ser qualquer fonte SHX ou TTF do Windows,
• Defina uma altura (height) para a fonte. Caso contrário, se a altura for = 0, o comando  dtext 

sempre pedirá a altura da letra,
• Define se será de cabeça para baixo (upside-down). Normalmente não se marca esta opção,
• Define o espelhamento (backward). Normalmente não se marca esta opção. Permite que as letras 

sejam escritas de modo espelhado - só a letra, não o texto,
• Define se será Escrita na vertical (vertical). Normalmente não se marca esta opção,
• Define a largura (width factor) para a fonte.Valores > 1 aumenta a largura da letra e < 1 diminui a 

largura da letra. Pode-se criar um estilo com widht factor  = 0.8 para textos pequenos, como os 
utilizados em numeração de pisos de escadas,

• Define o ângulo de inclinação (obliquing angle). Este ângulo configura uma aparência itálica para 
a fonte. Fontes que já são itálicas não necessitam desta mudança,

• Aplica-se e fecha o quadro de diálogo e o estilo será o corrente.

Caracteres especiais:
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Pode-se  escrever  com as  fontes  TTF,  utilizando  os  acentos  de  maneira  natural.  Para  manter 
compatibilidade com as versões anteriores, ainda utiliza os seguintes símbolos:

%%C = ∅ símbolo de diâmetro
%%D = ° símbolo de grau
%%U = texto sublinhado
%%O = texto sobrelinhado
%%P = ± símbolo de tolerância
Outros caracteres podem ser escritos, bastando para isto entrar com o seu código ASCII. Ex.: para 

escrever a letra “A” maiúscula é o mesmo que digitar “Alt + 65”.

Regra para altura de letras:
Um dos maiores problemas quando se trabalha com o AutoCAD em um sistema não padronizado, 

é as alturas de letras em relação a escala que se deseja desenhar. Uma simples regra permite calcular a 
altura da letra no comando Dtext em qualquer escala.

Considerando as alturas padrões das Réguas de Normógrafo (normalização ISO) em milésimo de 
polegadas e suas respectivas alturas em pontos e em centímetros, temos:

Tem-se a seguinte fórmula, para cálculo de alturas de letra em qualquer escala:

Obs.: o item ESCALA, é o denominador da escala de trabalho.

Ex.: Calcular a altura da letra no comando dtext  para a régua  CL-140 para desenhar em uma escala de 
desenho de 1/250, considerando que a unidade do desenho é centímetros.
H = 0.35 ∗ 250
H = 87.5 unidades de desenho
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11. Menu tools:

No menu TOOLS localiza-se várias ferramentas e comandos de 
configuração do ambiente de trabalho.
CAD  Standard  Associa  o  desenho  corrente  com  arquivos  de 
padrões.

Spelling É o corretor ortográfico do AutoCAD.

Quick Select...  Abre o quadro  Quick Select,  permitindo utilizar 
filtros para seleção de objetos;

Display  Order  Permite  mudar  a  ordem dos  objetos  como são 
mostrados na tela. Deve ser utilizado quando se faz um Hatch de 
sólido e este fica sobre as linhas do desenho.

Inquiry Este menu e barra de ferramentas contém comandos que 
permite fazer verificações no desenho, como distância, área e a 
coordenadas de um ponto (id).

Attribute Extraction... Permite a extração de atributos dos blocos 
selecionados. O comando gerará um arquivo que pode ser aberto 
no Microsoft Excel.

Properties (veja a paleta de ferramentas adiante).

Desing Center (veja a paleta de ferramentas adiante).

Tool Palettes Windows (veja a paleta de ferramentas adiante).

dbConect  Permite configurar o AutoCAD para acessar e trocar 
informações  do  banco  de  dados  dos  seguintes  programas: 
Microsoft  Access,  dBASE,  Microsoft  Excel,  Oracle,  Paradox, 
Microsoft  Visual  FoxPro,  SQL  Server  utilizando  os  recursos 

ODBC e OLE do Windows.

Load Aplication  Carrega programas externos (Lisp, ADS e ARX) dentro do AutoCAD, criando novos 
comandos.

Run Script Permite carregar Script (que são seqüência de comandos gravados em forma de texto ASCII) 
para execução de sequências de comandos.

Macro Carrega macros em Visual Basic, criando assim novos comandos ou automatizando tarefas dentro 
do AutoCAD.

AutoLISP Inicializa o programa Visual Lisp para criação ou edição de programas em LISP.
Display Image Visualizar imagens Raster dentro do AutoCAD. Este comando é ideal para inserir imagens 
de scanners dentro do AutoCAD, com, por exemplo, curvas de níveis ou uma imagem de satélite.
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Named, Ortographics, Move e New UCS Comandos para recursos 3D.

Wizards Carrega os assistentes para a configuração de Plotters e Layouts do desenho.

Tablet  Permite configurar uma mesa digitalizadora no AutoCAD. Também permite alternar o acesso do 
cursor entre o menu pull-down e sobre a área de digitalização.

Customize  Permite criar  uma personalização dos menus,  dos atalhos de teclados,  barras e paletas  de 
ferramentas.

Options Abre o quadro de diálogo de configuração de todo o ambiente do AutoCAD. Permite a alteração 
de um grande número de recursos do programa. Para um uso inicial do programa alguns itens devem ser 
alterados para uma maior produtividade.

Se você não tem conhecimento suficiente destas configurações, utilize com cautela esta opção para que o 
programa não apresentar uma forma estanha de trabalho.
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Ferramentas que merecem atenção:

Properties
Esta  paleta  de  ferramenta  permite  que  os  objetos  do 
AutoCAD  sejam  manipulados  com  grande  facilidade, 
permitindo fazer mudanças diversas sobre as entidades 
selecionadas,  como:  cor,  layer,  thickness,  elevation, 
posição.

Por  exemplo,  pode-se  selecionar  vários  objetos 
com o  grips  e então filtrar  para o objeto desejado.  Se 
você selecionou vários objetos e deseja modificar apenas 
os textos,  passe a seleção para  Text  e então no campo 
apropriado, escolha a alteração que deve ser executada. 
No caso do menu ao lado, foram filtradas 11 entidades
texto e foi aplicada a altura (height) igual a 10 a todas 
elas.

Quick Select
Dentro desta mesma ferramenta existe um botão de filtro 
que  abrirá  o  quadro  Quick  Select,  permitindo  uma 
seleção  mais  apurada  das  entidades  selecionadas. 
Também  pode  chamar  o  comando  pelo  menu 
Options→Quick  Select.  Você pode  aplicar  a  seleção  a 
um grupo de objetos selecionado com os grips ou a todo 
o desenho.

No quadro do comando ao lado, pode-se verificar que dentro de uma seleção de vários objetos por grips, 
fez uma filtragem para selecionar somente as entidades Text que tinham a altura igual a 10. O comando é 
extremamente  poderoso,  permitindo  que  sejam  feitas  a  seleção  com  a  combinação  de  propriedade, 
operadores e valores.

Design Center
Esta paleta de ferramenta permite um total controle dos desenhos existentes e o desenho que esta sendo 
editado, como pegar blocos,  layers,  textstyle, contido em um desenho que esta no disco rígido ou na 
internet e inseri-lo no desenho que esta sendo editado.  Ou copiar blocos,  layer  etc de outro desenho 
aberto. Pode utilizar esta ferramenta para localizar mais rapidamente os seus blocos a serem inseridos. 
Você pode também criar, por exemplo, um desenho que contenha todos os seus blocos de cozinha e deixar 
o Design Center explorar o arquivo para retirar os blocos desejados.

Tool Palettes Windows
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Este novo recurso existente no AutoCAD 2004, permite criar novas paletas de ferramentas que pode ser 
adaptada pelo usuário. No Exemplo ao lado, visualiza uma biblioteca de símbolos que foi adicionada à 
paleta. Para criar a sua própria paleta de símbolos, basta você abrir a paleta Design Center e arrastar os 
símbolos desejados para a sua paleta.

Drafting  Settings:  Permite  uma  completa  configuração  do  ambiente  do  desenho,  utilizando  várias 
configurações:

- Snap
Limita  o  movimento  do  cursor  X-hair  a  uma  malha  invisível.  Os  valores  podem  ser  alterados 
diferentemente tanto no X, como no Y, para trabalho com precisão. Por exemplo, em arquitetura utiliza-se 
normalmente o snap = 5.

- Grid Cria pontos de referência na tela, não sendo necessário que o seu valor acompanhe os valores do 
snap. Caso o grid tenha valor = 0, ele assumirá valor igual ao do snap. Tanto o grid quanto o snap podem 
ter valores diferentes no X e no Y. Quando você utilizar o comando Zoom e o AutoCAD responder com 
“Grid too dense to display”, isto significa que a sua grid está com um espaçamento muito pequeno para 
aparecer na tela. Mude o valor da grid para um valor maior.

-  Isometric  Transforma o cursor  X-hair  para os planos isométricos,  sendo utilizado para desenho de 
perspectivas isométricas. Ex: utilizando os comandos  line  e  ellipse  para o desenho isométrico pode-se 
construir o desenho ao lado. 

- Polar Snap Liga o snap para trabalha com distância e ângulos pré-definidos pela opção Polar spacing e 
pela aba Polar Tracking.

- Polar Tracking É o snap que funciona com ângulos pré-definidos na opção Polar Angle Settings. Pode-
se ligar o Polar snap pressionando a tecla F10 ou clicando na palavra polar na barra de status.  Para 
controlar  como  o  Polar  Snap  trabalha,  modifica-se  principalmente  a  opção  Polar  Angle  Settings, 
selecionando o ângulo desejado ou adicionando novos ângulos.

- Object Snap Permite travar as várias opções de Snap ao objeto, sendo:
-Endpoint Pega o ponto final de uma entidade.
-Midpoint Pega o ponto médio (meio) de uma entidade.
-Center Pega o ponto central de arcos, círculos e dunuts.
-Node Pega a entidade point.
-Quadrant Pega os quadrantes de arcos, círculos e dunuts, sendo, 0°, 90°, 180° e 270°.
-Intersection Pega a interseção de duas entidades.
-Extension Acha a extensão de uma linha. Trabalha em conjunto com o endpoint.
-Insertion Pega o ponto de inserção de blocos e texto.
-Perpendicular Pega o ponto perpendicular em referência a uma reta a partir do último ponto marcado na 
tela.
-Tangent Pega um ponto de um arco ou círculo tangente ao último ponto marcado na tela.
-Nearest Pega um ponto qualquer em uma entidade.
-Apparent Int Pega a interseção aparente de duas entidades.
-Parallel Desenha linhas paralelas a outras linhas existentes.
-Clear all Desativa todas as configurações do comando de object snap.
Obs: Nunca utilize todos os  Object Snap  ligados ao mesmo tempo, pois isto não ajudará muito na left 
rigth isométricas elipses top execução de um desenho. O ideal é trabalhar com uns quatro ou cinco object 
snap  ligado, tais como:  endpoint, midpoint, center, intersection  e  perpendicular. O  object snap nearest  
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deve ser usado com cautela, pois pode provocar erros por utilização indevida. Uma outra dica interessante 
é utilizar a tecla “TAB” do teclado para alternar entre os object snap ligados.

Toolbar Object Snap:
Esta barra de comandos  Object Snap permite o uso do comando de  Object Snap sem que fique 

travado. Por exemplo, dentro de um comando se você precisar de um object snap quadrant e não deseja 
manter-lo ligado, basta chamá-lo dentro desta barra que então desligará automaticamente após a execução 
do comando.

12. Menu format:

Layer, Color, Linetype e Lineweight Veja na seção Níveis de Trabalho.
Text Style Veja Criação e Edição de Texto.
Dimension Style Veja Dimensionamento.
Plot Style Veja na seção Imprimindo um Desenho.
Multiline Style Permite criar novos estilos de Multiline.
Point Style Veja na seção anterior em Point no ítem Menu Draw.
Multiline Style Permite carregar e modificar as propriedades de linhas múltiplas
Thickness Define uma altura de extrusão para linhas, círculos e polinhas, Normalmente utilizado para 3D.
Drawing Limits  Cria um limite  virtual para desenhar.  Neste limite  será onde aparecerão as  grids.  O 
comando pede-se dois pontos (um sendo o canto inferior esquerdo e o outro o canto superior direito da 
tela).

Normalmente este limite deverá ser maior que o objeto a ser desenhado.
Um bom modo de iniciar o seu trabalho é configurar o limite do desenho. Basta você começar o seu 
projeto normalmente e aumentar o limite do desenho de tal forma que o prédio caiba dentro dele. Por 
exemplo: se você desenha uma residência que tenha um total de 3800 centímetros (38 metros), o limite 
deve ser um pouco maior que este valor. Quando começar a definir a escala de trabalho e o formato que 
será impresso o desenho, deve-se obedecer a uma pequena regra para calcular o limite do desenho.

Em  nosso  caso  se  a  casa  for  desenhada  na  escala  de  1/50,  para  descobri  em  qual  formato 
deveremos fazer o desenho, basta multiplicar o formato pela escala:
Formato A3 – 42 x 29.7 x escala 1/50 = 2100x1405 → Formato muito pequeno.
Formato A2 – 59.4 x 42 x escala 1/50 = 2970x2100 → Formato ainda pequeno.
Formato A1 – 84 x 59,4 x escala 1/50 = 4200x2970 → Formato indicado – a casa com os seus 38 cm 
pode ser colocada dentro deste formato.

Units Controla como o AutoCAD apresenta as unidades e ângulos, sendo:
-Length Define qual será o tipo de unidade a ser utilizada. Normalmente decimal.
-Angle Define como será a apresentação dos ângulos.
-Precisão Define a quantidade de casas decimais. Normalmente é configurado em duas casas decimais.
-Direção Define como o AutoCAD mostra os ângulos. O usual é com o à direita (na posição de 3 horas) e 
o sentido é anti-horário. Somente em casos especiais, como em uso de engenharia de agrimensura, é que 
se deve modificar como o programa mostra os ângulos.
Depois se deve reconfigurar o programa para o padrão normal.

Rename Permite renomear entidades Blocks, Dimstyle, Layers, Linetype, Text Style, UCS, View, Vport.
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13. Níveis de trabalho:

Na barra de ferramentas LAYERS o primeiro ícone acessa o comando do quadro de diálogo Layer  
Properties Manager  para a criação de  layers  (camadas).  Todo o desenho deve-se ser feito em várias 
camadas. Cada camada pode ser utilizada por um tipo de informação do desenho, como camada para 
estrutura, paredes, cotas, símbolos, mobiliário, portas, janelas, detalhes, etc.

Quanto mais camadas tiverem no desenho, mais fácil será editá-lo. Em arquitetura uma quantidade 
de camadas em torno de 20 é o usual, mas tem empresas que utilizam mais de 400 camadas (para vários 
projetos diferentes, como incêndio, estrutura, elétrico, hidráulico, paisagismo, etc.).

O uso do recurso de Paper Space e de View Ports permite ter layer específicos para cada porta de 
visualização, podendo deixa-lo visível ou não em cada porta.

Analisando o quadro de diálogo de layers, temos:

-New Cria-se um novo layer com o nome de layer1, permitindo entrar com um novo nome.
-Delete Apaga um layer se ele não estiver sendo utilizado.
-Current Faz do layer selecionado o layer ativo.
-Named layer filters Permite selecionar que tipo de layer deseja visualizar. Na parte principal do quadro:
-Name Exibe o nome do layer.
-On Liga os layer selecionados.
-Lock Trava os layer selecionados
-Linetype Permite alterar o tipo de linha dos layer selecionados
-Color Altera a cor da camada
-Linetype Altera o tipo de linha da camada
-Lineweigth Altera a espessura da linha da camada
-Plot Style Define um estilo de plotagem para a camada
-Plot Permite que a camada seja ou não impressa
-Details Permite alterar mais detalhes do layer selecionado.

Quando estiver dentro de um layout, aparecerão mais estas opções:
- Active Viewports Freez Congela o layer somente das Viewport ativa.
-New Viewports Freez Congela o layer somente das novas Viewport.
O comando  Layer  também pode ser acessado pela linha de comando (digite -layer). Sub comandos do 
comando Layer aparecerão pedindo você escolher uma opção:
[?/Make/Set/New/ON/OFF/Color/Ltype/LWeight/Plot/Freeze/Thaw/LOck/Unlock/stAte]:

? Mostra os layers existentes

Make Cria um novo layer que se torna corrente

Set Muda o layer corrente

New Cria um novo layer, mas não fica corrente

ON Liga um layer

OFF Desliga um layer, mas o computador mantém o seu processamento

Color Muda a cor de um layer
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Ltype Muda o tipo de linha de um layer

LWeight Muda a espessura da linha

Plot Configura a camada para que seja ou não impressa

Freeze Congela um layer, o computador não processa

Thaw Descongela o layer

LOck Trava um layer, não permitindo a sua edição.

UNlock Destrava o layer.

14. Entrada de dados:

Além do  mouse,  as  informações  de  coordenadas  podem ser  passadas  ao  AutoCAD pelo  teclado  de 
maneira precisa, informando numericamente como o programa deve agir. Muitas vezes é necessário este 
procedimento, pois o mouse não permitirá que se chegue ao resultado desejado.

Coordenadas absolutas:  São coordenadas que utilizam informações de x,y,z para a localização de um 
ponto.

Ex.: P1=10,9 P2=7,6,3

Coordenadas relativas: São coordenadas que utilizam as informações relativas a um ponto anterior para 
definir um novo ponto, com o acréscimo de valores para x,y,z.
Ex.: @1,0 anda 1 unidade no x e 0 no y
@0,1 anda 0 unidade no x e 1 no y
@0,-1 anda 0 unidade no x e -1 no y

Coordenadas polares: São coordenadas que utilizam as informações relativas a um ponto anterior para 
definir um novo ponto, mas com informações de direção de distância.
Ex.: @3<0 anda 3 unidades no x e 0 no y
@3<90 anda 0 unidade no x e 3 no y
@3<30 anda 2.59 unidades no x e 1.50 no y
P2
h=3 y=1.5
@=P1
x=3∗sen30° = 2.59
y=3∗cos30° = 1.5
obs: @ é o útimo ponto marcado na tela.

Também pode-se entrar com os dados relativo a um ponto no AutoCAD R2000 de maneira muito simples, 
bastando marcar o ponto na tela, indicar a direção e a distância numericamente.

Filters: Permite filtrar informações das coordenadas, utilizando-os com outras informações, sendo:
.x Filtra o valor x de uma coordenada e pede novos valores para yz
.y Filtra o valor y de uma coordenada e pede novos valores para xz
.z Filtra o valor z de uma coordenada e pede novos valores para xy
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.xy Filtra os valores xy de uma coordenada e pede um novo valor para z

.xz Filtra os valores xz de uma coordenada e pede um novo valor para y

.yz Filtra os valores yz de uma coordenada e pede um novo valor para x

Desde a versão R-2000 o AutoCAD tem o comando OTRACK (Comando Object Snap Tracking na barra 
de  status)  que  permite  de  uma  maneira  muito  fácil  capturar  coordenadas  de  objetos  existente  para 
construir uma nova coordenada.

Para  utilizar  o  comando,  ligue  também o  Object  Snap  desejado e  dentro  de  um comando de 
desenho (por ex. o Line), leve o cursor sobre o ponto de onde deve recolher a coordenada X e espere (não 
dê nenhum click) até aparecer o nome do osnap na tela, e desça lentamente o cursor. Então aparecerá uma 
linha pontilhada passando pelo ponto escolhido e um pequeno sinal de + no local do ponto escolhido. 
Repita a operação para localizar a coordenada Y. Agora leve o cursor de modo este que passe sobre os 
dois pontos escolhidos (X e Y), criando assim um novo ponto no desenho. Aparecerá então duas linhas 
tracejadas  pelos  pontos  escolhidos  pelo  o  Otrack,  e  também  aparecerá  DOIS  Object  Snap 
simultaneamente. Neste momento já está configurado o Otrack para o comando, bastando dar um click e a 
linha começará exatamente na nova coordenada X,Y.

15. Comandos de visualização:

Pode encontrar o comando Zoom na barra de ferramentas

Standard, ou no menu VIEW que é dedicado à visualização do desenho. Nele localizam-se os comandos 
de visualização mais utilizados no AutoCAD.
Redraw Força um redesenho da tela, sem provocar uma regeneração.
Regen Força uma regeneração da tela, mostrando as curvas de arcos e círculos como realmente devem 
aparentar (sem ficar sextavado).
Zoom Permite aproximar ou afastar de um objeto.

Toolbar Zoom:

Variações do comando Zoom:

 Z. Realtime Permite modificar a magnitude de visualização em tempo real com o auxilio do mouse.�
 � Z. Previous Volta à tela de zoom anterior.
 � Z. Window Visualiza uma janela definida sobre o desenho.
 � Z. Dynamic  Faz um controle  de visualização dinâmica sobre o desenho,  permitindo aproximar ou 

afastar de um local do desenho. Dentro do comando um quadro aparece inicialmente, representando a área 
do  zoom  anterior.  Com o botão de  pick  do  mouse  o X do quadrado muda para uma seta,  permitindo 
aumentar (afastar do desenho) ou diminuir (aproximar do desenho) a área de zoom. Move-se o quadrado 
sobre a área que deseja visualizar e completa o comando com enter. A linha tracejada verde representa o 
limite do desenho, e se o quadrado com X sair desta área, aparece uma ampulheta, que significa que o 
comando vai forçar uma regeneração no desenho.

 � Z.Scale Multiplica a tela atual por uma nova relação de zoom. Ex:zoom 3x aumenta a tela atual 3 vezes. 
zoom .3x reduz a tela para 30% da tela atual.  zoom 3 aumenta 3 vezes a tela em relação a tela definida 
pelo limits.

 � Z. Center Permite fixar um ponto e aplicar o zoom sobre este ponto.
 � Z. In Permite aproximar do desenho (fator de escala 2).
 � Z. Out Permite afastar do desenho (fator de escala 0.5).
 � Z. All Visualiza todo o desenho mais o limite definido pelo comando limits.
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 � Z.Extend Mostra a extensão máxima que o desenho pode ocupar na tela.

Outros comandos e recursos de visualização:
Pan Realtime  Permite arrastar a tela de visualização sobre o desenho, sem modificar a magnitude de 
visualização em tempo real com o auxilio do mouse. O comando pede dois pontos para o movimento da 
tela.
Pan Point Semelhante ao anterior, só que o comando pede dois pontos para o movimento da tela. Pode-se 
utilizar as Barras de Rolagem (Scroll Bar) para mover a tela de visualização sobre o desenho, de modo 
semelhante ao comando Pan.
Comandos transparentes Pode-se utilizar os comandos zoom e pan dentro de outros comandos, bastando 
colocar um apostrofo (`) na frente do comando. Acessando o comando pelo menu pull-down ou pela barra 
de ferramentas zoom o comando já é transparente. Alguns outros comandos também são transparentes.

16. Processos de seleção:

São processos para selecionar uma ou um grupo de entidades para aplicar-lhe um comando sobre estas 
entidades.

Single Seleciona uma entidade de cada vez com o pick box..
Crossing  Seleciona as entidades que o retângulo tracejado (crossing)  de seleção estiver contendo ou 
passando sobre elas.
Window Seleciona as entidades que estiverem totalmente dentro do retângulo contínuo
(window) de seleção.
Auto Abre-se o retângulo de seleção automático, para esquerda o retângulo é de crossing e para direita é 
de window.
Box Seleciona os objetos através de um retângulo, por dois pontos.
CP Crossing-Poligon. Seleciona-se por crossing através de um polígono.
WP Window-Poligon. Seleciona-se por window através de um polígono.
Last Seleciona a última entidade desenhada na tela.
Fence Seleciona as entidades por uma linha de crossing (cerca).
All Seleciona todas as entidades da tela que não estão em um layer travado.
Group Seleciona todas as entidades de um determinado grupo.
Remove Remove do grupo de seleção as entidades selecionadas.
Add Sai da opção remove e volta adicionar entidades ao grupo de seleção.
Undo-U Retira do grupo de seleção a última entidade selecionada.
Previous Pega o grupo anterior de entidades selecionadas. Normalmente um grupo criado pelo comando 
select.
Filters Comando de seleção mais complexo que o comando Qselect, permitindo a escolha da entidade ou 
características da entidade a ser selecionada. Digite na linha de comando: Filter.

17. Processos de edição por grips:

No processo de edição normal do AutoCAD, escolhe-se um comando de edição (ex.: move = verbo, ação) 
e aplicasse sobre uma entidade (ex.: linha = nome)
-Comando usa: verbo-nome (açãoentidade)
Quando seleciona um objeto sem nenhum comando na linha de comandos, acendem-se os  grips  de cor 
azul nas entidades selecionadas.
-Grips usa: Nome-verbo (entidade-ação) Estando os grips de cor azul, qualquer comando de edição pode 
ser aplicado sobre as entidades selecionadas, sem ter que seleciona-las novamente. Quando um desses 
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grips  é  selecionado,  ele  fica  de  cor  vermelha.  Estando  os  grips  vermelhos,  cinco  comandos  estão 
disponíveis,  sendo:  stretch,  move,  scale,  rotate  e  mirror.  Também pode-se utilizar  a  opção  reference 
dentro de cada comando, modificando o ponto de atuação (base point) do comando sobre os objetos.
O modo como os grips trabalham pode ser alterado pelo quadro de diálogo Grips através do menu Tools 
→ Options→ Selection.

18. Blocos:

A manipulação de blocos é uma das ferramentas mais poderosa do AutoCAD, permitindo a construção de 
bibliotecas de desenhos padrões para posterior utilização. Os blocos nada mais são que simples desenhos 
feitos normalmente no editor do AutoCAD. Eles devem ser salvos no disco rígido (HD) para posterior 
utilização. Um ponto importante a se observar na construção dos blocos é em relação ao seu  ponto de 
inserção. Também se deve considerar o  layer  das entidades. Se for um bloco de símbolo que possa ser 
utilizado em qualquer camada (layer), deve-se fazê-lo no  layer 0, e quando inserido no desenho, este 
assumirá o layer corrente na inserção.
Bmake Este comando cria uma entidade “bloco” com as entidades selecionadas. Este bloco criado existe 
somente no desenho em edição Ex.: Para fazer o bloco de uma porta de 80 cm, desenhe uma polilinha 
fechada e um arco. Entre com o comando Bmake e aparecerá o quadro de diálogo ao lado. De um nome 
ao bloco, por exemplo, P-80, selecione o ponto de base, como indicado no desenho ao lado, este será o 
ponto de inserção do bloco, quando você utiliza-lo. Selecione os objetos que compõe o bloco, e click no 
OK. O seu bloco está pronto, mas lembre-se que ele existe somente neste seu desenho que esta sendo 
editado.

Wblock:
Entre com este comando no prompt para criar um bloco e grava-lo no H.D como um desenho DWG. O 
bloco criado com o comando  bmake  ou  block  também pode ser gravado com o comando  wblock.  O 
quadro de diálogo do Wblock e semelhante ao do Mblock, só que permite gravar o seu bloco no disco 
rígido (HD). Note que se você fez um bloco com o comando Mblock, selecione em Source a opção Block 
e escolha o bloco existente que você deseja gravar em disco.

Insert block (ddinsert)
Este comando insere no desenho os blocos existentes no desenho ou no disco rígido. Permite ainda a 
mudança de escalas no x,  y,  z  e  rotação.  Selecione todas  as  três  opções  Specify on screen,  senão o 
programa vai inserir o bloco no ponto, escala e rotação especificado dentro do quadro de diálogo.
Também pode explodir um bloco, desagrupando suas entidades, durante ou depois de sua inserção no 
desenho. É importante saber como utilizar a rotação e valores de inserção negativos. 

Redefinição de blocos:
É possível redefinir um bloco no desenho, refazendo o bloco com o comando Bmake, ou inserindo um 
novo bloco com o comando insert block e respondendo sim para o prompt de redefinição.
Base: Define ou altera o ponto de inserção de um bloco.
Group Localizado no menu Tools→ Object Group, este comando é muito semelhante ao comando Block, 
o comando  Group  cria a partir  de uma seleção um grupo de objetos,  permitindo manipula-los muito 
facilmente. Veja o quadro de diálogo ao lado. Pode-se utilizar este comando quando não deseja criar 
blocos, já que o comando group permite que as entidades em seu interior sejam editadas com comandos 
como trim, break, etc.

19. Atributos:

Menu : Draw→Block→Define.Attributes.
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Os atributos são blocos especiais, constituídos de um ou mais textos de atributos e desenhos. Estes textos 
podem  ser  preenchidos  durante  a  inserção  do  bloco.  Os  atributos  também  permitem  a  extração  de 
informações do AutoCAD para um programa de banco de dados como o Microsoft Access, já sendo este 
tópico parte de um curso mais avançado. No quadro de diálogo  Attribute Definition, define o modo de 
apresentação do atributo, o rótulo (tag), a pergunta (prompt) que o bloco lhe fará quando inserido e o 
valor de preenchimento (value) do campo quando inserido. O Ponto de inserção é o lugar onde o texto 
será localizado dentro do bloco. As opções de texto referem-se à altura de letras, fontes e justificativa. 
Lembre-se que quando faz um bloco de simbologia,  como um símbolo de planta ou um carimbo de 
prefeitura, a altura do texto deverá estar na escala de 1/1, ou seja, um texto na régua 80, terá 0,2 cm. 
Acima vemos o quadro de dialogo durante a inserção de um bloco de atributos mais complexo como o 
carimbo de prefeitura. Como pode-se ver, este quadro tem vários campos a serem preenchidos (o botão 
Next).

20. Controle de escala dos blocos:

Para saber quais blocos devem sofrer fator de escala durante a inserção, deve-se ter em mente apenas o 
seguinte: Todos os textos, dimensionamento, símbolos ou blocos que não existem em uma obra real, 
sofrem fator de escala. Isto significa que todos os blocos de simbologia, como o símbolo de planta, norte 
magnético, formato, textos, dimensionamento, terão as suas escalas multiplicadas pela escala de trabalho.
Por exemplo:
Em um projeto de uma residência que será apresentada na escala de 1/50 (obs: o desenho da residência 
sempre será feito na escala de 1/1), o texto deverá ser aumentado em 50 vezes, as cotas deverão ser 
aumentadas em 50 vezes, o norte magnético, o símbolo de nível e o formato deverão ser aumentados 50 
vezes, pois nenhuns destes itens existem na obra após a sua execução. Em compensação, o bloco de vaso 
sanitário, a geladeira, a mesa da sala, o automóvel na garagem e o homem na varanda da fachada da 
residência sempre serão inseridos na escala de 1/1, pois estes itens existem na obra após a sua construção. 
Uma grande confusão que sempre acontece, é a utilização de blocos que estão em unidades diferentes do 
seu desenho. Se você estiver fazendo o desenho em unidades de centímetros, deve-se utilizar os blocos 
construídos em centímetros

21. Dimensionamento:

São os seguintes comandos de dimensionamento:

Quick Dimension Apenas com uma seleção do objeto, o programa inicia um dimensionamento rápido.
Linear Executa um dimensionamento linear, podendo ser horizontal e vertical.
Aligned Executa o dimensionamento alinhado a dois pontos.
Radius Dimensiona o raio de arcos e círculos com o símbolo R.
Diameter Dimensiona o diâmetro de arcos e círculos com o símbolo ∅.
Angular Dimensiona ângulos.
Baseline Faz as medidas a partir de um ponto de base. Normalmente utilizado para desenho mecânico.
Continue Permite continuar os dimensionamentos DimLinear, DimAligned, DimOrdinate e DimBaseline.
Leader Coloca linha e seta com texto explicativo, utilizando o Multitext.
Tolerance Cria anotações de tolerância.
Center Mark Marca o centro de arcos e círculos com uma cruz (+).
Oblique Permite modificar a inclinação das linhas de chamadas das cotas. Utilizado principalmente para 
desenho isométrico.
Align Text Permite modificar a posição do texto da cota.
Style Abre o quadro de diálogo de configuração dos parâmetros de dimensionamento.

Eletrotécnica – Desenho Auxiliado por Computador 27



Escola Estadual de Educação Profissional [EEEP] Ensino Médio Integrado à Educação Profissional

Override  Pode-se criar um novo estilo de dimensionamento cujas configurações sobrepõem ao estilo 
corrente, permitindo criar pequenas alterações nas cotas.
Updade Força as cotas antigas a mudarem para o estilo de dimensionamento corrente.
Reassociate Dimensions  Na versão R-2004 todos os objetos de dimensionamento são associados aos 
objetos  que  originou  a  cota.  Uma mudança  nas  dimensões  do  objeto  original  fará  a  cota  modificar 
automaticamente o seu valor. Com este comando, pode-se mudar a associação a este objeto fonte para um 
outro objeto desejado.
Dimensiom Style
Abre o quadro de diálogo para a configuração de dimensionamento. Neste quadro várias configurações 
deverão ser ajustadas para um perfeito dimensionamento. Na realidade, este quadro modifica as variáveis 
de  dimensionamento  (Dimvar)  que  mantém  controle  sobre  as  cotas.  Se  você  utiliza  um  protótipo 
Template já configurado com um estilo de dimensionamento,
e deseja criar mais um novo estilo, basta dar um click no botão New e especificar um novo nome para este 
novo estilo (Ex: BASE-50) e será criado como uma cópia idêntica do estilo existente. Para adaptar este 
estilo para a nova escala de trabalho, click no botão  Modify  e click na aba  Fit. No campo Use overall  
scale of:, mude o valor para a sua escala (no nosso exemplo = 50).
Uma dica:  como foi  comentado antes,  o  dimensionamento é  um objeto  que deverá  mudar  de escala 
conforme a escala de trabalho. Por exemplo, para definir um estilo para a escala 1/50, inicialmente crie 
um estilo de dimensionamento chamado de BASE-50 e dentro da aba Text  defina a altura da letra (text  
height) em 0,2 unidades (normalmente só faz a cota com a régua 80, ou seja, 0,2 cm de altura) e dentro da 
aba  Fit, modifique o valor em  Use overall scale of:  para 50. O que você fez foi multiplicar todas as 
informações de dimensionamento por 50, inclusive o texto, que nesta escala terá uma altura de 0,2 x 50 = 
10 unidades. Os quadros de diálogo de dimensionamento são muito complexos. Para estuda-los melhor, 
procure informação no Help on line do AutoCAD.
No  AutoCAD  2004  ainda  existe  o  prompt  especial  de  dimensionamento  (DIM:)  para  manter 
compatibilidade com as versões anteriores do programa. Para entrar neste  prompt  digite  Dim. Para sair 
deste prompt, digita-se Exit ou Crtl+C Ctr+C.

22. Paper space e model space:

Até agora somente tem-se desenhado no Model Space, ou seja, no espaço do modelo. Este espaço tem um 
ícone com duas setas representando o X e Y (e na versão R2000 tem um W no eixo do Z), que indica o 
WCS, ou World Cordinate Sistem - Sistema de Coordenadas Global, normalmente utilizado para desenhos 
em duas e três dimensões.
Pode-se criar vários  Layouts  para a visualização e organização do desenho a ser impresso, com ele é 
possível criar várias portas de visualização do modelo que está no Model Space. Com estas portas, pode-
se controlar a escala e layers a ser visualizado.
Quando se trabalha com apenas uma escala no desenho, é preferível utilizar somente o Model Space para 
desenhar, mas com várias escalas a opção mais simples é o uso do Layout (ou Paper Space). Verifique 
mais adiante o processo de impressão para as duas opções. Quando se está na opção Layout, o ícone do 
WCS transforma-se num esquadro. O comando  Layout  é acessado pela  barra de Navegação  e permite 
alternar entre o Model Space e os Layouts existentes.
Estando no espaço do modelo e dando um click no botão Model ,você irá para o Layout e o comando de 
impressão será  acionado.  Pode-se cancelar  o  quadro de diálogo de configuração de página.  Agora o 
comando Model existente na barra de Status permite alternar entre o Model Space e Paper Space. Note 
que estando no dentro da opção Layout e acionando o botão Paper você acessa a porta de visualização. 
Nota: dentro da opção  Paper  pode-se trabalhar na edição do modelo, mas não é usual – Normalmente 
entra nesta opção somente para o uso do Pan e do Zoom XP.

Pode-se criar novos Layouts utilizando o Wizards disponível para esta função. 
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(menu Tools→Wizards→Create layout)
Para criar novas portas de visualização dentro dos novos layouts é necessário estar dentro da opção Paper 
Vá ao menu View→Floating Viewports→Viewport 1  e crie as suas novas portas de visualização. Estas 
portas  podem ser  movidas,  copiadas,  apagadas  ou editadas  pelos  grips,  de  modo a  serem mais  bem 
diagramadas  dentro  do formato  de desenho.  As portas  podem ser  de formato  retangular,  circular  ou 
irregular. Deve-se criar estas portas dentro de um layer específico (por exemplo, VPORT), de modo que 
possa ser congelado antes da impressão.
Fator ajuste de escala do desenho utilizando o comando o Zoom:
Após a criação das portas de visualização,  deve-se corrigir  a  escala  que cada desenho é apresentado 
dentro de cada porta. Vá a opção  Model  e selecione a porta desejada com um  click. Agora execute o 
comando Zoom digitando no teclado (Z) e complete com a escala desejada (e mais XP).
Exemplo, para uma escala de:
1 / 50 → utiliza-se o zoom = 1/50 xp
1 / 100 → utiliza-se o zoom = 1/100 xp
1 / 331/3 → utiliza-se o zoom = 0.03 xp (onde 0.03 = 1/331/3).
2 / 1 → utiliza-se o zoom = 2 xp

Atenção: O bloco de formato de papel quando inserido no Layout, deverá ter a escala =1.
 Se você desenha em unidade de metro, o bloco de formato de papel deve ser desenhado em metros.�  

Portanto um formato A-1 inserido no Layout terá 0.84x0.594 unidades
 Se você desenha em unidade de centímetro,  o bloco de formato de papel  deve ser desenhado em�  

centímetros. Portanto um formato A-1 inserido no Layout terá 84x59.4 unidades
 Ainda é possível criar e congelar  � layers  específicos para cada porta de visualização, de modo que o 

mesmo desenho visualizado por duas portas diferentes, pode ter informações visíveis apenas nas portas 
desejadas, para isso, vá ao comando de Layer e na coluna Current VP Freeze congele os layers desejados.

23. Imprimindo um desenho:

Inicialmente, estando no Paper Space, congele o layer VPORT das portas de visualização.
Verifique e modifique o valor do Ltscale.
Se você estiver imprimindo no Model ou Layout, siga a regra abaixo:

Preview  de impressão:  Execute  o comando  Preview  de impressão antes de imprimir.  Faça-o também 
dentro do comando Plot.

24. Dentro do comando plot:

O comando Plot  do AutoCAD 2004 está muito mais completo (e complexo) do que a versão R-14. Na 
versão R-2000 existem vários  Helps  em forma de vídeo disponível no programa. Estes  helps  dão uma 
visão clara dos novos comandos e seus usos. Sempre em caso de duvidas, consulte-os.
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Como imprimir no AutoCAD 2004:
 Primeiro verifique ou modifique o dispositivo de impressão (impressora ou  � plotter). Se não tiver o 

dispositivo de impressão apropriado, cancele o comando e vá ao menu  Tolls→Options→Plotting, e no 
botão  Add  or  Configure  Plotters  para  instalar  uma  nova  impressora.  Ou  também  em 
Tolls→Wizards→Add Plotter.

 Vá ao menu Files e chame o comando � Plot, que abrirá o quadro de diálogo mostrado acima.
 Verifique ou altere as penas e suas correspondências com as cores das entidades no AutoCAD. Isto só�  

será possível dependendo do dispositivo de impressão instalado.
 Na opção � Window, selecione os limites do formato a ser impresso. Se for imprimir uma parte apenas do 

desenho, tente manter a janela de window mais próxima da proporção do papel a ser impresso.
 Selecione ou crie um novo tamanho de papel a ser impresso. Note que o papel a ser impresso não pode�  

ser maior que o máximo especificado pelo programa.
 Selecione ou altere a rotação do formato a ser impresso.�
 Na opção � Plot Scale, defina a escala a ser impressa o desenho, sendo:

Preview  Após  todos  os  itens  verificados,  faça  uma  visão  prévia  do  desenho  para  evitar  erros  na 
impressão. Se desejar um arquivo de impressão, na opção File Name... pode-se aceitar o nome default ou 
especificar um outro nome para o arquivo de impressão (se a opção de Plot to File estiver ligada). Leva-se 
o arquivo de plotagem (.PLT) para um Bureal de Serviço e está pronto o desenho (você deve configurar 
em seu computador um plotter do mesmo tipo existente no Bureal).
Os plotters a jato de tinta tem-se 255 cores de penas diferentes, com um número infinito de espessura de 
traço  para  cada  cor,  sendo  praticamente  ilimitado  as  possibilidades  de  configurações  para  cores  e 
espessuras de traço destinado a cada uma das 255 cores do AutoCAD. Cada cor do plotter representa uma 
caneta, sendo, portanto 255 canetas em 255 cores diferentes. Dentro do quadro  Plot Style table Editor, 
normalmente utiliza-se a caneta preta (em  Properties→  Color→Black) para desenhar as linhas pretas, 
configurando todas as cores do AutoCAD para desenhar com a cor Black, mas com cada cor do AutoCAD 
com as suas correspondências de espessuras para os diferentes de tipos de traços (mude as espessuras em 
Lineweight).
Quando Imprimir escolha no campo  Plot Style Table  a opção  Momochrome  ou  Grayscale.  Você pode 
configurar tanto impressoras ou plotters dentro do comando de impressão.

25. Outros comandos:

Existem vários outros comandos no AutoCAD que também merecem um pouco mais de atenção. Estes 
comandos já pertencem a um nível mais elevado de estudo, portanto não entraremos em maiores detalhes 
sobre os seus usos.

Xref  Permite  trabalhar  com arquivos  externos  de desenhos referenciados  (um pouco parecido com o 
Bloco na visualização, mas completamente diferente no conceito). Ë um recurso interessante para projetos 
complexos, onde, por exemplo, a estrutura do edifício poderia ser um desenho referenciado e não um 
Bloco  inserido  dentro  do  desenho.  Se  o  calculista  modifica  a  sua  estrutura,  todos  os  desenhos  que 
possuírem aquele Xref também modificarão.
Options  Faz o ajuste do programa com os equipamentos utilizados, ex.:  impressora,  plotter,  monitor, 
mouse,  mesa  digitalizadora,  etc.  Quando  é  instalado  o  AutoCAD,  este  assume  as  configurações  do 
Windows. Para acrescentar um novo plotter ou impressora, deve-se refazer a configuração.

Menu Help:

Help Mostra o Help online do AutoCAD
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Escola Estadual de Educação Profissional [EEEP] Ensino Médio Integrado à Educação Profissional

Active Assitance Liga um assistente que fica localizado na bandeja do sistema do Windows (system tray),  
explicando cada comando que é executado no AutoCAD e ainda permite utilizar pesquisa de ajuda dentro 
do quadro do Active Assitance.
Developer Help Carrega o help mostrando como personalizar o AutoCAD.
New Features Workshop Carrega programa de multimídia descrevendo novas características.
Online Resources Permite localizar na web mais informações sobre o AutoCAD.
About Mostra Informações sobre o AutoCAD.

Bibliografia:
• Dominando o AutoCAD 14
George Omura
•  Manual do Usuário - AutoCAD 2004
Autodesk Inc.
Emr-Bhz 04/04/2004
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Hino do Estado do Ceará

Poesia de Thomaz Lopes
Música de Alberto Nepomuceno
Terra do sol, do amor, terra da luz!
Soa o clarim que tua glória conta!
Terra, o teu nome a fama aos céus remonta
Em clarão que seduz!
Nome que brilha esplêndido luzeiro
Nos fulvos braços de ouro do cruzeiro!

Mudem-se em flor as pedras dos caminhos!
Chuvas de prata rolem das estrelas...
E despertando, deslumbrada, ao vê-las
Ressoa a voz dos ninhos...
Há de florar nas rosas e nos cravos
Rubros o sangue ardente dos escravos.
Seja teu verbo a voz do coração,
Verbo de paz e amor do Sul ao Norte!
Ruja teu peito em luta contra a morte,
Acordando a amplidão.
Peito que deu alívio a quem sofria
E foi o sol iluminando o dia!

Tua jangada afoita enfune o pano!
Vento feliz conduza a vela ousada!
Que importa que no seu barco seja um nada
Na vastidão do oceano,
Se à proa vão heróis e marinheiros
E vão no peito corações guerreiros?

Se, nós te amamos, em aventuras e mágoas!
Porque esse chão que embebe a água dos rios
Há de florar em meses, nos estios
E bosques, pelas águas!
Selvas e rios, serras e florestas
Brotem no solo em rumorosas festas!
Abra-se ao vento o teu pendão natal
Sobre as revoltas águas dos teus mares!
E desfraldado diga aos céus e aos mares
A vitória imortal!
Que foi de sangue, em guerras leais e francas,
E foi na paz da cor das hóstias brancas!

Hino Nacional

Ouviram do Ipiranga as margens plácidas
De um povo heróico o brado retumbante,
E o sol da liberdade, em raios fúlgidos,
Brilhou no céu da pátria nesse instante.

Se o penhor dessa igualdade
Conseguimos conquistar com braço forte,
Em teu seio, ó liberdade,
Desafia o nosso peito a própria morte!

Ó Pátria amada,
Idolatrada,
Salve! Salve!

Brasil, um sonho intenso, um raio vívido
De amor e de esperança à terra desce,
Se em teu formoso céu, risonho e límpido,
A imagem do Cruzeiro resplandece.

Gigante pela própria natureza,
És belo, és forte, impávido colosso,
E o teu futuro espelha essa grandeza.

Terra adorada,
Entre outras mil,
És tu, Brasil,
Ó Pátria amada!
Dos filhos deste solo és mãe gentil,
Pátria amada,Brasil!

Deitado eternamente em berço esplêndido,
Ao som do mar e à luz do céu profundo,
Fulguras, ó Brasil, florão da América,
Iluminado ao sol do Novo Mundo!

Do que a terra, mais garrida,
Teus risonhos, lindos campos têm mais flores;
"Nossos bosques têm mais vida",
"Nossa vida" no teu seio "mais amores."

Ó Pátria amada,
Idolatrada,
Salve! Salve!

Brasil, de amor eterno seja símbolo
O lábaro que ostentas estrelado,
E diga o verde-louro dessa flâmula
- "Paz no futuro e glória no passado."

Mas, se ergues da justiça a clava forte,
Verás que um filho teu não foge à luta,
Nem teme, quem te adora, a própria morte.

Terra adorada,
Entre outras mil,
És tu, Brasil,
Ó Pátria amada!
Dos filhos deste solo és mãe gentil,
Pátria amada, Brasil!






